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Abstract

powerdot is a presentation class for IKIgX that allows for the quick and easy de-
velopment of professional presentations. It comes with many tools that enhance
presentations and aid the presenter. Examples are automatic overlays, personal
notes and a handout mode. To view a presentation, DVI, PS or PDF output can be
used. A powerful template system is available to easily develop new styles. A IyX

layout file is provided.
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1 Introduction

This class gives you the possibility to easily create professionally looking slides. The
class is designed to make the development of presentations as simple as possible so
that you can concentrate on the actual content instead of keeping yourself busy with
technical details. Of course, some knowledge of BTEX is still required though.

This class builds on and extends the prosper class [9] and the HA-prosper package
[1]. The HA-prosper package was initially intended to extend prosper and correct some
bugs and problems of that class. As developments on that package progressed, it was
found that unfortunately, not all of the problems could be overcome with the package.
That discovery was the start of a new project set up to make a new class to replace
the prosper plus HA-prosper combination. You're currently reading the result of that
project.

The remainder of this section will be devoted to giving a feel of what the powerdot
presentation source looks like and giving an overview of this documentation.

The document structure of a presentation is always the same. You can find it in the
example below.

\documentclass[<class options>]{powerdot}
\pdsetup{<presentation options>}
\begin{document}
\begin{slide}{a slide}
Contents of the slide.
\end{slide}
\section{first section}
\begin{slide}[<slide options>]{another slide}
Contents of the slide.
\end{slide}
\begin{note}{personal note}
The note.
\end{note}
\end{document}

There are several elements that define the document structure. First of all, the class
accepts some class options that control the output of the class, for instance, paper
type and style. These class options will be discussed in section 2.1. Then there are
presentation specific options which control some of the elements of the presentation
globally, for instance, the footers. These will be discussed in section 2.2.

Once the setup has been decided on, you can use the slide environment to produce
slides (see section 3) and the note environment to produce notes that go with the slides
(see section 6.1). You can use overlays to display material in steps. This is described in
section 4. The \section command provides a way to structure your presentation. This
is discussed in section 5. Section 7 will show an overview of the styles that come with
this class and the characteristics of each style. Section 8 will tell you more about how to
produce output. This section contains important information on required packages.

Section 9 is mostly interesting for people that want to develop their own style for
this class or want to modify an existing style. Section 10 explains how IyX [6] can be
used to create powerdot presentations. This documentation concludes with a section
devoted to questions (section 11), like “Where can I find examples?’. It also tells you
where to turn to in case your questions are still not solved.

2 Setting up the presentation

This section will describe all options that are available to control the output of the
presentation and the looks of it.



2.1 Document class options

We will start with the class options that are typed in the \documentclass command
as a comma-separated list. For each option, the preset value' will be mentioned in the
description. This is the value that will be used if you decide to not give a value to the
option or not use the option at all.
option This options controls the kind of output that we want to produce. The preset value
mode jspresent.

mode=present

This mode is used when you want to create the actual presentation. It will enable
overlays and transition effects. You can read more about overlays in section 4.

mode=print

This mode can be used when printing the slides including their visual markup,
but without any overlay or transition effects.

This mode will produce a black and white overview of your slides that can be
used to make personal notes on, for distribution to students, a personal guide
during your talk, etcetera.

nohandoutpagebreaks

By default, the handout mode produces a document with two slides per
page. If you want to fit more slides on a page, specify this option in
the \documentclass command and powerdot will let BTgX decide on the
places to insert a page break, namely when a page is full.

|nohandoutframes|

By default, the handout frames the slides. This option will remove the
frames around slides on handouts.

option This option has five possible values. The preset value is screen.

paper
paper=screen

This is a special format with screen optimized ratio (4/3). The actual page di-
mensions will be 8.25 inch by 11 inch. This paper format is not available for
print or handout mode. In these modes, powerdot will switch to a4 paper and
put a warning that it did this in the log file of your presentation.

‘paper=a4paper‘

A4 paper will be used for the presentation or handout.

‘paper=1etterpaper‘

Letter size paper will be used.

‘paper=smartboard‘

For presentation on a smartboard (widescreen).

paper=169

For a presentation on a screen with 16:9 ratio.

1 The value that will be used when you don't use the option.



Some important information with respect to paper size, compiling and viewing pre-
sentations is available in section 8.

option This controls the orientation of the presentation. The preset value is 1andscape.
orient

orient=landscape

The presentation will be in landscape format. This value is not available in hand-
out mode. In that mode, powerdot will switch to portrait orientation and will
warn you about this in the log file.

orient=portrait

This produces slides in portrait format. Notice that not all styles support por-
trait orientation. Please refer to section 7 for information about which styles do
support the portrait orientation.

option This controls the production of slides and notes. The preset value is slides.
display

‘display=slides‘

This will only typeset the slides in your presentation.

‘display=slidesnotes‘

This will typeset both the slides and the notes in your presentation. See also
section 6.1 for more information about notes.

‘display=notes‘

This will typeset the notes only.

Here are some more options to control the output.

option size

size This is the size of the normal text font in points. Possible values are 8pt, 9pt, 10pt,

11pt, 12pt, 14pt, 17pt and 20pt and the preset value is 11pt.?

option style
style

This controls the style to be loaded for the presentation. By default, the default
style will be loaded. For more styles, see section 7.

option fleqgn
flegn

This option makes equations flushed left. It does the same as the equally named
option for the article class.

option legno

legno
Put equation numbers at the left. Also the same as in the article class.
nopsheader

By default, powerdot will write a postscript command to the ps file to make sure
that post processors like ps2pdf know which paper to use without the need to
specify it on the command line. See also section 8. If you experience problems
with post processing or printing or you want to specify the paper size in the post
processing steps yourself, use this option.



option

hlentries
This highlights table of contents entries when the entry matches with the

current slide and its preset value is true. See also section 5. If you don't
want highlighting of table of contents entries (for instance in print mode), use
hlentries=false.

option

hlsections
This highlights table of contents sections when the section matches with the cur-

rent section in the presentation and is preset to false. See also section 5. Spec-
ifying this option turns highlighting of sections on. This could be useful when
you are using a style that implements a split table of contents.

pauseslide . . . . . . .
This option inserts a black slide in the presentation on page 1 and will auto-

matically advance to page 2 when opening the presentation in a PDF viewer like
Acrobat (Reader). The option also inserts a link behind every slide or section title
that brings you to the black slide when clicked. When you click anywhere in the
black slide, you will go back to the originating slide. This option can be used to
temporarily pause a presentation, for instance, to do a proof on the black board.
Optionally, a color can be supplied, for instance, pauseslide=white to have a
pause on a white screen.

options

clock This displays a small digital clock on slides which you can use to check the time

left for your presentation.

Here is an example of a \documentclass command.

\documentclass [
size=12pt,
paper=screen,
mode=present,
display=slidesnotes,
style=tycja,
nohandoutpagebreaks,
pauseslide,
flegn

J{powerdot}

This example sets up a presentation in tycja style, with a black slide, normal size 12
points and flushed left equations.

\documentclass[
size=12pt,
paper=letterpaper,
mode=handout,
display=slidesnotes,
style=tycja,
nohandoutpagebreaks,
pauseslide,
flegn

J{powerdot}

Changing the paper and mode options, now produces a handout with possibly more
than two slides per page due to the nohandoutpagebreaks option.

2Note that sizes other than 10pt, 11pt and 12pt are non-standard and it is assumed that you have the
extsizes bundle [11] installed, which provides these sizes.



2.2 Setup options

\pdsetup There are several extra options that can help customizing your presentation. These
options are not available via the \documentclass command. This has a technical
reason.> We distinguish two types of options. Options that can only be set globally
(acting for the entire presentation) using the \pdsetup command and options that
can be accessed both globally (via \pdsetup) and locally (via slide environments, see
section 3).

2.2.1 Global options

This section describes options that can only be used globally in the preamble of your
presentation via the \pdsetup command.

option palette

alette
P This specifies the palette to be used. A palette is a set of colors defined by a style.

To find out which palettes are defined by each style, see section 7.

option

theslide
This option controls how the slide number appears on the slide. This is preset

to the value \arabic{slide}~/~\pageref*{lastslide}, which could appear
like 5/22. Notice that the \arabic{slide} typesets the number of the current
slide and that \pageref*{lastslide} typesets the number of the last slide.*

option

thenote
This is similar to the theslide option, but typesets the slide numbers of

notes. The preset value is note™\arabic{note}~of“slide™\arabic{slide}
and \arabic{note} here typesets the number of the current note that goes with
the current slide. This could appear like note 2 of slide 7.

option

counters . . .
The counters option lists counters that you might want to protect on over-

lays. As material on overlays (see section 4) is processed multiple times, also
KIEX counters, like the equation counter, might be increased too often. To
avoid that your equations get different numbers on every overlay, use this op-
tion. The equation, table, figure, footnote and mpfootnote counters are
already protected for you. If you use extra counters, for instance for theorems,
list them in this option. Example:

‘ counters={theorem,lemma}

option

list . . . . . :

This option takes a list of options that will be passed on to the enumitem package
that controls the layout of lists created by the enumerate and itemize environ-
ments. Example:
‘ list={labelsep=1lem,leftmargin=%, itemsep=0pt,topsep=5pt,parsep=0pt}
See for more information on controlling the layout of lists the enumitem package
(4].

options | enumerate | | itemize

enumerate 3 B . . .
 bemi The interested reader is referred to the section about the xkvltxp package in the xkeyval package docu-
itemize

mentation [2].
4We use the starred version of \pageref which is defined by hyperref and does not create a link to the
page that it is referring to.



As the 1ist option, but only control enumerate and itemize environments re-
spectively.

option clockformat

clockformat
This option specifies the format of the clock. The format is set using Acrobat’s

util.printd function.’ The default value is HH:MM: ss, which shows a 00-23
hour, 00-59 minute, 00-59 second clock. Example:

clockformat=h:MM tt

The above setting will display a 1-12 hour, 00-59 minute, am/pm clock. That is,
the clock might show 5:53 pm.

option clockrefresh

lockref h
crockretres This option should be a number which specifies how often the clock is refreshed

in milliseconds. The default behavior is to refresh the clock every second. Thus,
the default value is 1000. Notice, if the clockformat is such that seconds are not
shown, then it makes no sense to update that clock every second. A correspond-
ing example:

clockrefresh=60000

The interpretation of this is that the clock will be updated every minute.

2.2.2 Global and local options

This section describes options that can be used both globally via \pdsetup and locally
via slide environments (see section 3).

11 This determines the content of the left, center and right footers. These are preset
cf to empty.
rf
option
trans

This option sets the default transition effect to be used in the presentation. These
transition effects only work after compiling the presentation to PDF format. See
also section 8. The following transition effects are supported: Split, Blinds,
Box, Wipe, Dissolve, Glitter and Replace. When you are using a viewer that
understands PDF 1.5, you can also use Fly, Push, Cover, Uncover or Fade. It
is important to notice that most viewers are case sensitive, so, for instance, box
will not work.

The preset effect is Replace which just replaces one slide with another when
browsing the slides. Note that some PDF viewers (like Acrobat Reader 5 and
higher) only produce the transition effect in full screen mode. If you want to
use a custom transition effect that is not listed in the list above (for instance, a
wipe effect with a custom wipe direction), then that is possible. However, power-
dot will put a warning in your log file that the effect that you have chosen, might
not work in the PDF viewer. Here is an example that does work.

trans=Wipe /Di 0

In Acrobat (Reader), this wipes from left to right instead of the default top to
bottom. For more information, see a PDF Reference Manual.



option
method

options
logohook
logopos
logocmd

option
randomdots

options
dmindots
dmaxdots

options
dminsize

dmaxsize

options
dminwidth
dmaxwidth
dminheight
dmaxheight

This option can be used when a slide contains special material that does not
get treated in the ‘usual’ way by BIgX. Verbatim material is an example of this.
Possible values are normal (the preset value), direct and file. We will come
back to this option in detail in section 6.4.

logohook‘ ‘ logopos ‘ ‘ logocmd‘

If logopos is specified, a logo defined by the value of the logocmd option
will be put on slides. The position can be specified relative to the width
and height of the slide. {0,0} is the lower left corner of the paper and
{\slidewidth,\slideheight} is the upper right corner. For positioning the
logo, the \rput command of pstricks [16, 17] is used. This command also allows
to specify the point of the logo that should be positioned there. This point can
be entered via the logohook option and can take the values t1, t, tr, r, Br, br,
b, b1, B1, 1, B and c. For more information about \rput, consult the pstricks
documentation. Here is an example that integrates the flower of the default style
into the husky style.

\documentclass [style=husky]{powerdot}
\pdsetupq{
logohook=t,
logopos={.088\slidewidth, .99\slideheight},
logocmd={\includegraphics [height=.08\slideheight]{powerdot-default.ps}}
}
\begin{document}

\end{document}

The preset value for logohookis t1.

A special feature of powerdot, which can be used to make presentations come alive,
is the use of random dots. These dots will be placed anywhere on your slides and use
the colors defined by the palette that you use. Overlays will carry the same dots. This
feature uses random. tex [3]. Several options are available to control the appearance
of the random dots.

By default, random dots are turned off. If this option is set to true, random dots
will be generated. false will turn off the feature. When no value is submitted to
the option, true will be used.

| dmindots | | dmaxdots |

The number of dots per slide is also random. These options set the minimum
and maximum dots per slide. Preset values are 5 and 40, respectively.

| dminsize| | dmaxsize|

The minimum and maximum radius of the dots. Preset values are 5pt and 40pt,
respectively.

[dminwidth| |dmaxwidth| |dminheight| |dmaxheight

These options determine the area on the slide that can be used for the random
dots. These values are preset such that dots go anywhere on the slide, but you
might want to adjust these such that, for instance, dots can only appear in the
text area. The preset values are Opt, \slidewidth, Opt, \slideheight.

Here is an example that allows dots in a smaller rectangle on the slide.

5For a complete listing of allowable formats, consult the Acrobat JavaScript Scripting Reference[13].



option
dbright

option
dprop

\pdsetupq{
dminwidth=.1\slidewidth,dmaxwidth=.9\slidewidth,
dminheight=.2\slideheight ,dmaxheight=.8\slideheight

}

This option can be used to adjust the brightness of the dots. The number should
be an integer between -100 and 100. If the number is negative, the color will
be adjusted towards black, with -100 giving black. If the number is positive, the
color will be adjusted towards white, with 100 giving white. With a light back-
ground, you may want to choose bright to be positive. With a dark background,
you may want to set it negative. The preset value is 60, meaning a mixture of 40%
of the original color and 60% white.

This option is used for passing extra parameters to the \psdot command, which
creates the random dots. You could, for instance, change the style of the dots or
the line width. See for more information about \psdot the pstricks documenta-
tion [16, 17]. powerdot defines two extra dot styles that can be used for the ran-
dom dots. These styles are ocircle (open circle) and osquare (open square).

Here are two examples for the use of random dots.

\pdsetupq{
randomdots ,dminwidth=.2\slidewidth
}

This turns on random dots and doesn’t use the left 20% of the slide for placing random
dots.

\pdsetupq{
randomdots ,dprop={dotstyle=ocircle,linewidth=.5pt},
dminsize=500pt,dmaxsize=600pt,dmindots=2,dmaxdots=5
¥

This example puts at most 5 big circles on slides. These circles do not fit on the slides
and you will only see parts of them in the shape of curves.
2.2.3 \pdsetup example

Here is an example of a \pdsetup command that one could use to set up the presen-
tation.

\pdsetupq{
1f=My first presentation,
rf=For some conference,
trans=Wipe,
theslide=\arabic{slide},
randomdots ,dmaxdots=80

¥

This sets the left and right footers and will initialize the transition effect to Wipe. Fur-
ther, slide numbers will not include the number of the last slide, but only the number
of the current slide. Finally, slides will be covered with at most 80 random dots.

A small note is necessary with respect to the appearance of footers. The slide num-
ber (controlled by the theslide option) will be added to a footer. Most styles add it
too the right footer. If both the footer and the slide number are non empty, ~--"~ will be
inserted in between them to separate them. Styles might modify this default behavior
however.



\title
\author
\and

\date
\maketitle

slide

option
toc

3 Making slides

3.1 Thetitle slide

The title slide is created by the \maketitle command.

\maketitle[{options)]

Its use is the same as in the standard BIEX document classes. The optional argument
(options) can contain any option from section 2.2.2. Specifying such an option in the
\maketitle command will only have an effect on the title slide and not on other slides.
See an example below.

\documentclass{powerdot}
\title{Title}
\author{You \and me}
\date{August 21, 2005}

\begin{document}

\maketitle

\end{document}

The author, title and date declarations provide the text to be used when making a
title page. The design of the title page is specific to the style in use. Notice the use of
\and for separating multiple authors. See a K[gX manual [12] for more information on
commands such as \titleand \author.

3.2 Other slides

The centerpiece of every presentation is the slide. In powerdot, the content of each
slide is placed in a s1ide environment.

\begin{slide} [{options)]{(slidetitle)}
(body)
\end{slide}

In section 4 we'll see how to give some life to the slides, but for now, let’s look at a
simple example.

\begin{slide}{First slide}
Hello World.
\end{slide}

The slide environment has one required argument, namely the slide title. When a slide
is created, the slide title is used to create an entry in the table of contents and in the
list of bookmarks. The table of contents is a listing of the slides and section titles in the
presentation that appears on each slide.

The table of contents is clickable (when the presentation is compiled into PDF)
and serves as a nice way to jump from location to location within the presentation.
The bookmark list is only present when compilation is taken all the way to the PDF file
format. It also serves as a table of contents, but this list does not appear on any of the
slides, but in a separate window in a PDF viewer. In the example above, the entries in
both table contents and the list of bookmarks would be titled First slide.

The (options) for the slide environment can contain any option listed in sec-
tion 2.2.2. Additionally, the following options can be used.

toc

When specified, the value is used for the entry in the table of contents; otherwise,
the slide title is used. If toc=is specified, then no entry is created.

10



option
bm

\pause

When specified, the value is used for the bookmark entry; otherwise, the slide
title is used. If bm= is specified, then no entry is created.

These optional arguments are especially useful when the title of a slide is extremely
long or when the title contains BIEX commands that do not render correctly in the
bookmarks.® When specifying entries, be sure to hide special characters ‘,” and ‘=’
between curly brackets ‘{” and ‘}. Let’s look at an example that uses these optional
arguments.

\begin{slide}[toc=,bm={LaTeX, i*i=-1}]{\color{red}\LaTeX, $i~2=-1$}
My slide contents.
\end{slide}

In this example, the slide title will appear as I, i = —1. This text will not render
correctly in a bookmark entry. An attempt is made to correct this, but often, the correc-
tion does not produce an equivalent text. This particular title would be rendered in the
bookmark list as redLaTeX, i2=-1.On the other hand, the manually specified book-
mark entry is rendered as: LaTeX, i*i=-1. Notice, no entry is created in the table of
contents, because of the use of toc=.

In addition to the s1ide environment, each individual style can define its own en-
vironments. Many styles have a wideslide environment. The idea is that one might
have information that does not fit nicely on a slide with a table of contents listed, as
this consumes some space. In such cases, it is preferable to use a slide that does not list
the table of contents. The wideslide environment provides this functionality and has
more space for the actual slide content. See section 7 for information on the various
environments provided by the styles.

4 Overlays

It is often the case that you don’t want all the information on the slide to appear at
once. Rather, the information should appear one item at a time. In powerdot, this is
achieved with overlays. Each slide can be comprised of many overlays, and the overlays
are displayed one at a time.

4.1 The \pause command

The easiest way to display information sequentially is to use the \pause command.

\pause [(number)]

Below is a simple example:

\begin{slide}{Simple overlay}
power\pause dot

\end{slide}

The slide’s information is displayed and continues until the \pause command is en-
countered. No further output within the same slide is displayed until the click of the
mouse or the touch of the keyboard. Then, the content will continue to display until
all the information is displayed or until another \pause command is encountered. In
this example, power is displayed on the first overlay, and powerdot is the displayed
on the second overlay. The \pause command is often used within the itemize and
enumerate environments. For example,

6The bookmarking procedure uses \pdfstringdef from the hyperref package, and it can process ac-
cented characters such as \"1i.

11



option
type

\begin{slide}{Multiple pauses}
power\pause dot \pause
\begin{itemize}
\item Let me pause\ldots \pause
\item \ldots while I talk \pause and chew bubble gum. \pause
\item Perhaps you’ll be persuaded.
\item Perhaps not.
\end{itemize}
\end{slide}

Since \pause was used before the itemize environment, no item will appear until
the third overlay. Then, each item will be displayed one at a time, each on their own
overlay. More information on using lists will follow in the next section.

The optional argument of the \pause command specifies the number of overlays
to pause. An example usage is:

\begin{slide}{Pause longer}
\begin{itemize}
\item A \pause
\item B \pause[2]
\item C
\end{itemize}
\end{slide}

In the example above, item C will appear on the fourth overlay. The usefulness of this
option will become more apparent in the next section; so we will revisit a similar ex-
ample at that time.

4.2 List environments

The list environments, itemize and enumerate, have special treatments in powerdot.
They have an optional argument that will be taken care off by the enumitem package
(see [4]). powerdot supplies an extra key for this optional argument. In the examples
that follow, features will be described using the itemize environment but they also
apply to the enumerate environment.

Here is the typical usage of the itemize environment:

\begin{slide}{Basic itemizel}
\begin{itemize}
\item A \pause
\item B \pause
\item C
\end{itemize}
\end{slide}

The display is simple, each item appears one at a time with each overlay.

Suppose we wanted every item to show, but we only wanted one item to appear
‘active’ at once. This can be accomplished via the type option for the itemize envi-
ronment. The preset value is 0.

\begin{slide}{Type 1 itemize}
\begin{itemize}[type=1]
\item A \pause
\item B \pause
\item C
\end{itemize}
\end{slide}

Now, every item will be displayed in the inactive color (which is defined by the style
that you use), and the item’s font color will become the active one on the overlay that it
would normally appear on. The default behavior is given by type=0. It is still possible
to pass optional arguments to enumitem via the second optional argument:

12



\item

\begin{slide}{Type 1 itemize}
\begin{enumerate} [type=1] [label=\romanx*a)]
\item A \pause
\item B \pause
\item C
\end{enumerate}
\end{slide}

Take care, that this must always be the second optional argument! It is possible to leave
the first one empty, which is valid only for powerdot.

Lists can also be nested to create complicated structures. When a list is nested, it
inherits the setting of the type option from the ‘parent’ list, but that can be overruled
by specifying the type option in the optional argument of the nested list. We present
here one example, but many more can be created by nesting lists of different types in
different ways.

\begin{slide}{Nested lists}
\begin{itemize}
\item A\pause
\begin{itemize}[type=1]
\item B\pause
\end{itemize}
\item C
\end{itemize}
\end{slide}

This displays A and B on the first overlay, but B is inactive. On overlay 2, B will become
active and on overlay 3, C will become visible.

4.3 The \item command

The \item command has an extra optional argument in powerdot which allows for
creating overlays in a more flexible way then \pause provides.

\item[(label)]<(overlays)>

This optional argument should contain an overlay specification stating on which over-
lays you want the item to appear. This specification is a comma separated list where
each item can used the notation as in table 1. The (label) argument is the standard

Syntax | Meaning

X Only overlay x
-X All overlays up to and including x
X- All overlays from x, including x

X-y All overlays from x to y, including x and y

Table 1: \item and \onslide notation

optional argument for \item in BIEX. A BKIgX manual [12] can tell you more about this
argument.
Here is an example.

\begin{slide}{Active itemize}
\begin{itemize}[type=1]
\item<i> A
\item<2> B
\item<3> C
\end{itemize}

\end{slide}
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\onslide

\onslide+

\onslidex*

Here we have said that A should only be active on overlay 1, B should only be active on
overlay 2, and C should only be active on overlay 3. Again, when the item is not active,
it appears in the inactive color because of type=1.

If type=0is specified and if each item is given an overlay option, then each item will
appear only when it is active. When the item is not active, then it will not show on the
slide at all. More examples demonstrating the syntax for (overlays) will be discussed in
the next section.

4.4 The \onslide command

Overlays can also be achieved using the \onslide command.

\onslide{(overlays)}{(text)}

This command takes an (overlays) specification as first argument and the (text) to ap-
ply it to as second argument. The (overlays) on which the text will appear are specified
as a comma separated list with syntax as in table 1. We start off with a simple example.

\begin{slide}{Simple onslide}
\onslide{1,2}{power}\onslide{2}{dot}
\end{slide}

We have instructed power to appear on overlays one and two, and dot to appear only
on overlay two. As you might guess, this example has the same output as our first
\pause example. Yet, it is clearly the case that our syntax is more complicated. How-
ever, this slight “complication” also allows for much more flexibility.

Consider the above example with the following modifications:

\begin{slide}{Simple onslide+}
\texttt{onslide }: \onslide{1}{power}\onslide{2}{dot}\\
\texttt{onslide+}: \onslide+{1}{power}\onslide+{2}{dot}

\end{slide}

The \onslide+ command displays its content in a different manner altogether. Now,
dot appears on every overlay, but it is in inactive color and matches the normal font
color only on overlay two. This is comparable to the type=1 behavior for lists (see
section 4.2).

When executing this example, we will also notice that the \onslide command
does hide material, but still reserves the right amount of space for it: on overlay 2,
the dots appear right above each other. The next command does not reserve space.

Instead of hiding and reserving space (\onslide) or putting (fext) in the inactive
color (\onslide+) when the overlay doesn’t match (overlays), this command just eats
the material altogether. To understand the differences, consider the following exam-
ple:

\begin{slide}{Simple onslide*}

\texttt{onslide }: \onslide{1}{power}\onslide{2}{dot}\\
\texttt{onslide+}: \onslide+{1}{power}\onslide+{2}{dot}\\
\texttt{onslide*}: \onslide*{1}{power}\onslide*{2}{dot}
\end{slide}

The output of the first two lines, we are already familiar with. The third line displays
power on overlay 1 and dot on overlay 2, but no space for power is reserved on overlay
2. Hence dot will start on the cursor position that power started on overlay 1 and it is
not aligned below the other two dots.

We finish with an example of the syntax that is possible with \itemand \onslide.
Remember that these commands take a comma separated list for the (overlays) speci-
fication and that each element can used the syntax as explained in table 1. The various
variations are demonstrated in the example below.
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\section

option
tocsection

\begin{slide}{Lists}
\onslide{10}{on overlay 10 onlyl}\par
\onslide{-5}{on every overlay before and including overlay 5}\par
\onslide{5-}{on every overlay after and including overlay 5}\par
\onslide{2-5}{on overlays 2 through 5, inclusivel}\par
\onslide{-3,5-7,9-}{on every overlay except overlays 4 and 8}
\end{slide}

4.5 Relative overlays

Sometimes it is a pain to keep track of when an item should appear or become active.
You might, for example, just care that some text appears on the overlay after some
other item. This functionality is provided through the use of relative overlays which
should not be used outside list environments that use \item. Let’s consider a simple,
illuminating example.

\begin{slide}{Relative overlays}
\begin{itemize}
\item A \pause
\item B \onslide{+1}{(visible 1 overlay after B)l}\pause
\item C \onslide{+2-}{(appears 2 overlays after C, visible until the end)}
\pause
\item D \onslide{+1-6}{(appears 1 overlay after D, visible until overlay 6)}
\pause
\item E \pause
\item F \pause
\item G \onslide{+1-+3}{(appears 1 overlay after G for 3 overlays)l}\pause
\item H \pause
\item I \pause
\item J \pause
\item K
\End{itemize}
\end{slide}

As you can see, we still use \onslide. The only change is with the syntax of the
list of overlays. Now, we can specify a ‘+’ symbol in the list. In its simplest usage,
\onslide{+1} will make text display one overlay after the overlay it would normally
appear on. You can still use the syntax in table 1. These are demonstrated in the above
example. Notice, \onslide{+1-6} means that the text will appear one overlay after
the overlay it would normally appear on and that the text should remain shown until
overlay seven. To make text appear for a range of relative overlays, see the final demon-
stration in the above example.

5 Presentation structure

5.1 Making sections

This section describes the \section command which provides a way to structure a
presentation.

\section[{options)]{(section title)}

This command will produce a slide with (section title) on it and will also use this text
to create sections in the table of contents and in the bookmarks list. There are several
(options) to control its output.

This option controls the creation of a section in the table of contents. The preset
value is true.
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option
slide

option
template

\tableofcontents

option
type

option
content

|tocsection=true

This does create a section in the table of contents. This means that all following
slides, until the next section, will be nested under this section.

|tocsection=false|

This does not create a section in the table of contents and hence the section will
be listed as an ordinary slide.

|tocsection=hidden|

This does create a section in the table of contents, but this is only visible when
you view a slide that is part of this section. This could be used to append a sec-
tion to the presentation which you can discuss if there is some extra time.

This option controls whether the \section command creates a slide. The preset
value is true.

A slide is created.

slide=false

No slide will be created. If also tocsectionis false, the \section command
doesn’t do anything. If it does create a table of contents section (tocsection=
true or hidden), its link will point to the first slide in the section as the section
itself doesn’t have a slide.

This option can be used to make the section slide with another template. By de-
fault, a normal s1ide environment is used to create the section slide, but if a style of-
fers other templates that could be used for this purpose (for instance, the wideslide
environment), then you can use this option to select that template. See section 7 for
an overview of the available templates with every style.

Finally, all options available to normal slides are available to slides created by
\section as well (see section 3). However, when the section does make a tocsection,
toc= or bm=won't remove the table of contents entry or the bookmark respectively.

5.2 Making an overview

This command creates an overview of your presentation and can only be used on a
slide.

\tableofcontents [(options)]

There are several (options) to control the output of this command.

This option controls whether certain material (depending on the input in the
content option below) will be hidden or displayed in the inactive color. The preset
value is 0. Compare with the type option for list environments (section 4.2).

When material is not of the requested type as specified in the content option, it
will be hidden.

As type=0, but instead of hiding material, it will be typeset in the inactive color.

The content option controls which elements will be included in the overview. The
preset value is all. The description below assumes that type=0 was chosen, but the
alternative text for type=1 can easily be deduced.
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note

emptyslide

content=all

This will display a full overview of your presentation including all sections and
slides, except the slides in hidden sections (see section 5.1).

|content=sections|

This displays only the sections in the presentation.

|content=currentsection|

This displays the current section only.

|content=future|

This displays all content starting from the current slide.

|content=futuresections|

This displays all sections, starting from the current section.

We finish this section with a small example that will demonstrate how you can
make a presentation that contains an overall overview of sections in the presentation,
giving a general idea of the content, and per section a detailed overview of the slides in
that section.

\begin{slide}[toc=,bm=]{0verview}
\tableofcontents [content=sections]
\end{slide}
\section{First section}
\begin{slide}[toc=,bm=]{0verview of the first section}
\tableofcontents [content=currentsection,type=1]
\end{slide}
\begin{slide}{Some slide}
\end{slide}
\section{Second section}

6 Miscellaneous

6.1 Notes

The note environment can be used to make personal notes that accompany a slide.
You can control displaying notes using the display option (see section 2.1). Here is
an example.

\begin{slide}{Chewing gum}

\end{slide}
\begin{note}{Reminder for chewing gum}

Don’t forget to mention that chewing gum is sticky.
\end{note}

6.2 Emptyslides

The emptyslide environment creates a totally empty slide. The text box on the slide
can be used for special things like displaying photos. This allows for creating a dia
show. Example:

\begin{emptyslide}{}
\centering
\vspace{\stretch{1}}
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thebibliography

option
verbatim

\includegraphics [height=0.8\slideheight]{me_chewing_gum.eps}
\vspace{\stretch{1}}
\end{emptyslide}

The \includegraphics command is defined by the graphicx package [5]. The
\stretch command is used to vertically center the picture. Both commands are de-
scribed in your favorite BIEX manual, for instance [12]. Note that you can use the
lengths \slideheight and \slidewidth to scale pictures to fit nicely on the slide.

6.3 Bibliography slide

powerdot redefines the standard article thebibliography environment to suppress
the creation of a section heading and running headers. All other properties are main-
tained. You can do either of the next two (depending whether you are using BiBTgX or
not):

\begin{slide}{Slide} \begin{slide}{Slide}
\cite{someone} \cite{someone}
\end{slide} \end{slide}

\begin{slide}{References} \begin{slide}{References}
\begin{thebibliography}{1} \bibliographystyle{plain}
\bibitem{someone} Article of someone. \bibliography{YourBib}
\end{thebibliography} \end{slide}

\end{slide}

In case you have a big reference list that you want to spread over multiple slides,
have a look at the packages natbib and bibentry [8]. Using both packages allows you to
do:

\begin{slide}{References (1)}
\bibliographystyle{plain}
\nobibliography{YourBib}
\bibentry{someonel}
\bibentry{someone2}

\end{slide}

\begin{slide}{References (2)}
\bibentry{someone3}

\end{slide}

Have a look at your favorite BIgX manual for more information about citations and
bibliographies.

6.4 Verbatim on slides

powerdot has three different methods of processing slides, from which two have mainly
been developed to make the inclusion of verbatim content’ on slides easier. These
methods can be accessed by the method key which is available in slide environments
and the \pdsetup command (see section 2.2.2).

| method=normal |

This is the preset method for processing slides. It is fast and allows for overlays,
but it does not allow for verbatim.?

method=direct

This method is also fast, but does not allow for overlays. Overlays will silently be
disabled. However, it does allow for verbatim content on slides.

7And other content that needs catcode changes when processing.
8Except when it has been saved in a box outside the slide.
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\twocolumn

option
lineheight

option
lineprop

method=file

This method uses a temporary file to export the slide body to and read it back
in. This method does allow for verbatim content and overlays, but could be slow
when many slides use this method because the filesystem is used.

Below is an example demonstrating the use of all three different methods of slide
processing.

\documentclass{powerdot}

\usepackage{listings}

\1lstnewenvironment{code}{%
\1stset{frame=single,escapeinside=¢’,
backgroundcolor=\color{yellow!20},
basicstyle=\footnotesize\ttfamily}

H}

\begin{document}

\begin{slide}{Slide 1}

Normal \pause content.

\end{slide}

\begin{slide}[method=direct]{Slide 2}

Steps 1 and 2:

\begin{code}

compute a;‘\pause’

compute b;

\end{code}

\end{slide}

\begin{slide}[method=file]{Slide 3}

Steps 1 and 2:

\begin{code}

compute a;‘\pause’

compute b;

\end{code}

\end{slide}

\end{document}

The first slide shows the default behavior for normal content. It produces two overlays.
The second slide does not produce overlays, despite the use of the \pause command.
This command has been disabled by choosing the direct method to process the ver-
batim content. The third slide has the same body as the second slide, but now does
create two overlays, because the method using a temporary file has been chosen. No-
tice that we used \pause inside the listing, but that it can also be used outside the
listing.

6.5 The \twocolumn command

The \twocolumn macro allows to split content into two columns.

\twocolumn [{options)] {{left) }H (right)}

This typesets (left) and (right) in two columns. The dimensions of those columns can
be controlled by (options). Below are the available options.

lineheight

If 1ineheight is specified, a line of the specified height will be created using
\psline in between the two columns. Example: 1ineheight=6cm.

Any pstricks declaration to specify the line properties. Example:

‘ lineprop={linestyle=dotted,linewidth=3pt}
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options
lfrheight
lfrprop

options
rfrheight
rfrprop
options
lcolwidth
rcolwidth
option
frsep

option
colsep

option
topsep

option
bottomsep

option
indent

‘ lfrheight ‘ ‘ lfrprop‘

The first creates a frame of the specified height around the left column. The
second is as 1ineprop, but for the left frame.

rfrheight ‘ ‘ rfrprop‘

As 1frheight and 1frprop, but for the right frame.

[1colwidth| |rcolwidth]

Width of the left and right columns. Both are preset to: 0.47\1inewidth.

frsep

Space between text and the frames. Preset: 1. 5mm.

colsep
Space between the two columns. Preset: 0.06\1inewidth.

topsep

The extra space (additional to \baselineskip)between text above the columns
and the text within the columns. Preset: Ocm.

bottomsep

Idem for the bottom of the columns. Preset: Ocm.

indent

Horizontal indent left to the left column. Preset: Ocm.

The dimensions described above are represented graphically in figure 1. Important
to notice is that the \twocolumn macro uses the current cursor position as the refer-
ence point to position the first line of text of the left column (see also figure 1). This
means that optional frames can extend to the text on the previous line. Use for in-
stance topsep=0.3cm in that case to add extra space between the two lines of text.
The preset value of topsep is based on the situation that there is no text on top of the
two columns. In that case, it is best to locate the first line of text of the left column at
the same spot as text that is not created by \twocolumn on other slides. The setting
topsep=0cm does exactly this. However, with a combination of topsep and indent
you can change this behavior and position the first line of text of the left column any-
where you want.

The \twocolumn macro computes the height of the construction to position text
below the construction correctly. The computation is done by taking the maximum
height of 1frheight, rfrheight, lineheight (if specified) and the left and right col-
umn content. Hence when frames nor a line is requested, bottomsep is the vertical
space between the lowest line of text in the columns and the text below the columns
(additional to \baselineskip). Here is an example.

\begin{slide}{Two columns}
Here are two columns.
\twocolumn[
1frprop={linestyle=dotted,linewidth=3pt},
lfrheight=4cm,rfrheight=5cm,lineheight=3cm, topsep=0.3cm
J{left}{right}
Those were two columns.
\end{slide}

Note that the use of the xkeyval commands \savevalue and \usevalue could be
handy here, for instance for copying the properties of the left frame to the right frame.
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Iﬁeft column text " :T(ight column text
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Bottom
Meaning of the labels
1 1lcolwidth 5 frsep
2 rcolwidth 6 topsep
3 colsep 7 1indent
4 1frheight,rfrheight, 8 Dbottomsep
lineheight 9 Reference point

Figure 1: Two-column dimensions.

This avoids typing them twice and avoids making errors resulting in different frames.
See an example below.

\twocolumn[
\savevalue{lfrheight}=3cm,
\savevalue{lfrprop}={
linestyle=dotted,framearc=.2,linewidth=3pt},
rfrheight=\usevalue{lfrheight},
rfrprop=\usevalue{lfrprop}
1{left}{right}

See the xkeyval documentation [2] for more information about \savevalue and
\usevalue.

7 Available styles

powerdot comes with a number of styles which are listed in the overview below. The
characteristics of each style are described shortly and a sample of a title slide and a
normal slide is provided for each style. Styles support the wideslide environment,
have a table of contents on the left part of the paper in landscape orientation and on
the bottom part in portrait orientation and support portrait orientation unless states
otherwise.
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default
This style provides six different palettes. A flower in the top left corner decorates
the slides for all palettes. The default palette is blue which has as main colors
light blue and white. You can see an example of that palette below. Other avail-
able palettes are red, green, yellow, brown and purple.

-
® - Example slide

Here is the binomium formula

)

Example of the default style

) on the blackboard
Hendri Adriaens Christopher Ellison

March 25, 2021

simple
This is a simple style in black and white. This style could be useful if you want to
print your slides.

Example slide
Example of the simple style Here is the binomium formula
(s by = S (M)
Hendri Adriaens Christopher Ellison (a+by ;(A) K &}
March 25, 2021 We will prove formula (1) on the blackboard
O Here
-
. s
. st
with
- seven
O items
e ah footer -1 et e fooer -2/ 2

tycja
This style is set in shades of yellow and dark blue. The table of contents on slides
is on the right side of the paper in landscape orientation and on the bottom part
in portrait.

Example slide

Example of the tycja style

Hendri Adriaens  Christopher Ellison

March 25, 2021

ikeda
This style uses dark shades of red and blue and a light text color. It has nice
patterns on the slide for decoration.

Example slide
)

Example of the ikeda style

Hendri Ad;

7 leee OIS
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fyma

This style was originally created by Laurent Jacques for prosper. Based on that
style, he created a version for HA-prosper with extended features. With his kind
permission, this style has been converted by Shun’ichi J. Amano for powerdot.
The style has an elegant design with a light blue and white gradient background
in the default blue palette. Other available palettes are green, gray, brown and
orange. It has special templates for sections on slides and sections on wide
slides. Below is a sample of the blue palette.

Example of the fyma style

We wil prove formula (1) on the blackboard

ciment
This style was originally created by Mathieu Goutelle for prosper and HA-prosper.
With his kind permission, this style has been converted for powerdot. The style
has a background that is hatched with light gray horizontal lines. Titles and table
of contents highlighting are done with dark red.

Example of the ciment style

Hendri Adriaens Christopher Elfison n Here

March 25, 2021

elcolors
This is a style using light shades of the elementary colors red, blue and yellow.

Example slide

Example of the elcolors style

Hendri Adriaens  Christopher Ellison

March 25, 2021

aggie
This style was created by Jack Stalnaker for HA-prosper and he has converted this
style for powerdot. The style uses dark red and light brown colors.
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Example slide

Here is the binomium formula.

=3 ()i ®

=2\

Example of the aggie style We will prove formula (1) on the blackboard.

Hendri Adriaens  Christopher Ellison . HE'Z
March 25, 2021 . a
lst
« with
seven
. items

husky
This style is created by Jack Stalnaker and has a background of light gray sun
beams combined with dark red highlights.

Example slide

Here is the binomium formula.

Example of the husky style (at+b)" =3 (L’)w ik @
=1
Hendri Adriaens  Christopher Ellison We will prove formula (1) on the blackboard.
March 25, 2021 R
is
- a
list
- with
seven
o items,

sailor
This style is contributed by Mael Hilléreau and supplies five different palettes:
Sea (the default), River, Wine, Chocolate and Cocktail. Below is a sample of

the palette Sea.

Here is the binomium formula.

Example of the sailor style (atby L (‘,“)w o o

We will prove formula (1) on the blackboard.

upen
This style has a nice dark blue background and text in yellow. It is contributed by
Piskala Upendran.
Example of the upen sf
bframe

The bframe style has blue frames on the slide in which text is positioned. The
style is contributed by Piskala Upendran.
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Example slide

Here is the binomium f

Example of the bframe style (a+b

We will prove formula (1) on the blackboard.
HendriAdriaens  Christopher Ellison

= Here

horatio
The horatio style has been contributed by Michael Lundholm and is a more con-
servative blue style.

Here is the binomium formula

Example of the horatio style (a+b)" =" () Kok (1)
Hendri Adriaens Christopher Ellison We will prove formula (1) on the blackboard.
Here
March 25, 2021

paintings

This is a simple style without a table of contents on slides. It has been con-
tributed by Thomas Koepsell and provides 10 different palettes. The colors used
in the palettes are drawn from famous paintings.® If you are interested, open
the style file to read which paintings have been used. The available palettes are:
Syndics (the default), Skater, GoldenGate, Lamentation, HolyWood, Europa,
Moitessier, MayThird, PearlEarring and Charon (all case sensitive). Below
is a sample of the Syndics palette.

Here is the binomium formula.
S A @
=3
Example of the paintings style We will prove formula (1) on the blackboard.
o Here
Hendri Adriaens  Christopher Ellison o is
.a
o list
* with
o seven
o items.

et footer ightfooter

klope
The klope style implements a horizontal table of contents that only lists the sec-
tions. The style is available in the following palettes: Spring, PastelFlower,
BlueWater and BlackWhite. The Spring palette is the default and you can see
a sample of that below.

9The style defines a color pdcolor7 which is not used in the style but comes from the same painting and
complements the other colors. It can be used, for example, to highlight text against the main background
color.
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Example of the klope style

Hendri Adriaens  Christopher Ellison

March 25, 2021 = Here

[ ol

jefka
The jefka style comes with four palettes: brown (the default), seagreen, blue
and white. Below you see a sample of the brown palette.

Example slide ‘
e nomium formula.

o f

Example of the jefka style

Hendri Adriaens  Christopher Ellison

March 25, 2021

pazik
This style is available in two palettes: red and brown. Below is a sample of the
default red palette.

Example slide

Example of the pazik style

8 Compiling your presentation

8.1 Dependencies

In table 2 is a list of packages that powerdot uses to perform specific tasks. Depen-
dencies of packages in this table are not listed. In the table, ‘required’ means that you
should have a version at least as new as listed and ‘tested’ means that powerdot was
tested with this version, but that it could equally well work with an older or newer ver-
sion than the one listed in the table. So, when trying to solve an error, first concentrate
on solving version issues for the ‘required’ packages. To find out which version of a
package you are currently using, put \1istfiles on the first line of your document,
run it with BIEX, open the .1log file and read the file list (see a BIgX manual for more
information). If you need to update a package, you can get it from CTAN [7].

8.2 Creating and viewing output

To compile your presentation, run it with BIgX. The DVI that is produced this way
can be viewed with MiKTgX’s DVI viewer YAP.!? Unfortunately, xdvi and kdvi (kile) do

10ynless you are using pstricks-add which distorts the coordinate system in DVI.
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Package/file Version Date Required/tested
xkeyval [2] 2.5¢ 2005/07/10 required
pstricks.sty[16, 17] 0.60 2013/12/12 required
xcolor [10] 1.11 2004/05/09 required
enumitem [4] 3.5.2 2011/09/28 required
article class 1.4f 2004/02/16 tested
geometry [15] 3.2 2002/07/08 tested
hyperref [14] 6.74m 2003/11/30 tested
graphicx [5] 1.1a 2017/06/01 required
verbatim 1.5q 2003/08/22 tested

Table 2: Dependencies

not support all PostScript specials and hence these will display the presentation incor-
rectly. If your DVI viewer does support this, make sure that your DVI display settings
match that of the presentation. In case you are using the screen paper, you should set
the DVI display setting to using the letter paper format. If your DVI viewer allows for
custom paper formats, use 8.25 inch by 11 inch.

Note that certain things that are produced with PostScript or PDF techniques will
not work in a DVI viewer. Examples are hiding of material via postscript layers (as is
done, for instance, by \pause, see section 4) and hyperlinks, for instance in the table
of contents.

If you want to produce a postscript document, run dvips over the DVI without any
particular command line options related to orientation or paper size. powerdot will
write information to the DVI file that helps dvips and ps2pdf (ghostscript) to create a
proper document. If you have some reason that this does not work for you and you
want to specify the paper and orientation yourself, you should use the nopsheader
option that is described in section 2. The PostScript document could, for instance, be
used to put multiple slides on a page using the psnup utility.

To create a PDF document for your presentation, run ps2pdf over the PS file created
with dvips. Also here, you can leave out any command line arguments related to paper
size or orientation. If this is problematic for you somehow, use the nopsheader option
as before and specify the paper and orientation at each intermediate step yourself.

9 Creating your own style

9.1 General information

Writing or customizing powerdot styles is simple. If you want to modify a style or
build a new one, locate the style that you want to use as basis in your TgX tree (styles
are named as powerdot-<style_name>. sty), copy that and rename it as to avoid li-
cense'! or naming conflicts. You might want to install the new style in your local TgX
tree to be able to access it from any place on your hard drive. See your BIgX distribution
for more information.

Once that has been taken care of, we can start creating the style. We strongly rec-
ommend to study a style file (for example, powerdot-default. sty) while reading the
remainder of this section as it provides good examples for the content of this section.

A style has several components. We describe these components below.

Identification and packages
This identifies the package in the log of a presentation and loads all required
packages. The default style contains something like:

HThe WIEX Public Project License requires renaming files when modifying them, see http://www.
latex-project.org/lppl.
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\NeedsTeXFormat{LaTeX2e}[1995/12/01]
\ProvidesPackage{powerdot-default}[2005/10/09 v1.2 default style (HA)]
\RequirePackage{pifont}

See for more information about these commands a BIEX manual, for instance
[12].

Palette or color definitions
This section contains the definitions of palettes or colors that you want to use in
the style. powerdot uses xcolor (via pstricks). Hence, for more information about
colors, see the xcolor documentation. We will discuss palettes in more detail in
section 9.2.

Template definitions
We will come back to this in sections 9.3 to 9.9.

Custom declarations
These can include anything that you want to be part of the style. The default
style, for instance, includes definitions for the labels in list environments like
itemize and some initializations for lists in general (done with \pdsetup, see
section 2.2). This part could also include some customizations as described in
section 9.10.

Font initializations
This initializes font definitions (which can be done by loading a package like
helvet).

9.2 Defining palettes

We will be defining templates formally in section 9.3. For now, it’s enough to have the

general idea that a template controls the design of a slide. Palettes are sets of colors that

color a template or design. A palette does not change the overall design of a template.
The following command can be used to define palettes for your style.

\pddefinepalettes{(namel)}{{cmdsl)}...

This macro takes any even number of mandatory arguments with a minimum of two.
For every (name), a set of (commands) can be given which define the palette with
name (name). These commands can define colors with names pdcolori, pdcolor2,
etcetera. These colors can be used when designing the template (see section 9.3).
pdcolor1 will always be used as text color.

The user can access these palettes via the palettekey for the \pdsetup command
(see section 2.2). If the user does not specify a palette, the first palette defined when
compiling the presentation, will be used. Here is an example for defining 2 palettes.

\pddefinepalettes{reds}{
\definecolor{pdcolori}{rgb}{1,0,0}
\definecolor{pdcolor2}{rgb}{1,.1,0}
\definecolor{pdcolor3}{rgb}{1,.2,0}

}greens}{
\definecolor{pdcolori}{rgb}{0,1,0}
\definecolor{pdcolor2}{rgb}{.1,1,0}
\definecolor{pdcolor3}{rgb}{.2,1,0}

}

In this example, the reds palette is the default one. For more information about
\definecolor, see the documentation of the xcolor package [10].

Notice that it is not necessary to use the names pdcolor?2, pdcolor3 etcetera as
color names. But if these colors are defined, powerdot will use them, for instance, in
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option
ifsetup

the random dots feature (see section 2.2.2). The flexibility adds extra possibilities in
setting up templates and palettes. See for an example of its use, the klope style.

9.3 Defining templates

We start off with a definition of what a template is. A template is a collection of set-
tings for slide components together with custom definitions, which controls the visual
appearance of a slide. A style can contain multiple templates.

\pddef inetemplate [(basis)]{(name)}{(options)} (commands)}

This defines the environment (name) to produce a slide with characteristics deter-
mined by (basis), (options) and {(commands). We will discuss these elements in more
detail in the coming sections.

If you want to create several templates that differ only slightly from each other,
define a (basis) template, and then use it to define other templates. All (options)
and (commands) for the new template (name) will be appended to the existing list
of (options) and (commands) from the (basis) template.

Make sure you choose a proper name for the template, and avoid redefining exist-
ing templates or environments. powerdot defines pauseslide,note and emptyslide
internally, so you shouldn’t use these names unless you know what you're doing. Fur-
thermore, each style needs to define at least the templates slide and titleslide.
The titleslide environment will be used to create the title slide and s1lide will (by
default) also be used to create section slides. Titles and sections are a bit special in the
way they use the (options) and will be discussed in more detail in section 9.10.

9.4 Controlling setup

The (options) (keys) are described in the following sections. You can control how these
options apply to the various setups by using the ifsetup key. Any key appearing be-
fore the first if setup declaration in (options) will apply to every possible setup. Once
the ifsetup key is used, then all subsequent key declarations will apply only to the
setups declared in the ifsetup key. The ifsetup key can be used multiple times.

By possible setups, we mean the allowed values of the mode, paper, orient, and
display keys that are described in section 2.1. If a value (or values!) for any of these
four keys is not specified in a ifsetup declaration, then all subsequent key declara-
tions will apply to any layout of that type. Consider the following as an example.

textpos={.2\slidewidth,.3\slideheight},%
ifsetup={portrait,screen},
textpos={.3\slidewidth,.2\slideheight}}

ifsetup=landscape,’%

ifsetup,

© W N ® o A w N e

Assuming there was no ifsetup declaration before the first textpos declaration, this
first textpos will apply to every possible setup. However, for the screen format in
portrait orientation, the next textpos declaration will be used. In fact, all declarations
that appear until we switch to the next ifsetup (which specifies all paper sorts and
only landscape orientation) will be used in the portrait screen layout. All keys after
the next ifsetup declaration will be used in landscape orientation, with any paper,
mode and display. If, after declaring some specializations, you want to switch back
to settings that apply to all possible setups, set ifsetup to empty as is done in the
example. All subsequent declarations will then again be applied under any setup.
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\pd@noportrait

option
title-

option
text-

option
toc-

option
stoc-

option
ntoc-

options
1f-
cf-
rf-

The following command is a stand-alone implementation of the mechanism de-
scribed above. It allows you to control the setup outside the (options) argument of the
\pddefinetemplate command.

\pdifsetup{(desired)}{{true)}{(false)}

This macro executes (true) when the setup that the user chose matches with the
(desired) setup, (false) in all other cases. For instance, if the user has chosen landscape,
then

\pdifsetup{landscape}{yes}{no}

will typeset yes. If the user would have chosen portrait instead, then no would have
been typeset.

This macro can be used to check setup requests from the user and, for instance,
generate an error if a certain setup is not supported by your style. powerdot provides
one predefined error message which can be used in one of the first lines of your style.

\pd@noportrait

This macro generates an error when the user requests portrait orientation. Notice that
the handout mode only works in portrait orientation. This macro takes that into ac-
count and doesn’t generate an error in the case that the user requested a handout.

9.5 Main components

The (options) control several key components of a slide. Every component has sev-
eral properties. A key that can be used in the (options) argument is the name of the
component postfixed by its property that you want to control.

The components title, text, toc, stoc and ntoc have properties hook, pos,
width and font. Additionally, the text component has a height property. The com-
ponents 1£f, cf and rf have properties hook, pos, temp and font. Hence, examples of
valid keys are titlefont, tocpos and 1ftemp. All components and properties will be
discussed below.

Here is an overview of the components that can be controlled from the (options)
argument in \pddefinetemplate.

ct

.

ct

=

(0]
|

The slide title.

text-

The main text box on the slide.

toc-
The (full) table of contents on a slide containing sections and slides.

stoc-

This is a table of contents containing only the sections. See also ntoc below.

ntoc-

This is a table of contents containing only the entries for the active section. To-
gether with stoc, this can be used to create a split table of contents. In a partic-
ular template, one would usually have a toc, a combination of stoc and ntoc or
no table of contents at all.

[1£-] [c£-] [r£-]

The left, center and right footers.
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-hook

option
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option
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option
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Notice that all positioning of components described above will be done with \rput
from pstricks [16, 17] internally. See the pstricks documentation for more information
about this command. It should also be noted that all components (except 1f, cf and
rf) put their content in aminipage environment.

Now we list all properties of the components listed above and describe what they
mean. Remember that keys are formed by combining a component name and a prop-

This option defines the \rput hook that will be used when positioning the item.
This canbe t1, t, tr, r, Br, br, b, b1, B1, 1, Band c. See the pstricks documenta-
tion for more information.

This defines the position of the hook on the paper. The lower left corner of
the paper is given by the point {0,0} and the upper right corner by the point
{\slidewidth,\slideheight}. So if you want to position the main text box at
20% from the left edge and 30% from the top edge of the paper, you have to do
the following.

textpos={.2\slidewidth,.7\slideheight}

If the position of any component has not been specified, this component will not
be placed on the slide. This gives an opportunity to design slides without footers
or table of contents, for instance.

The width of the component. All component positioned by powerdot will be put
in a surrounding minipage environment. The width property determines the
width of the minipage. Example:

‘ textwidth=.7\slidewidth

This property does not exist for the 1f, cf and rf components.

This option is only available for the text component. In other words, for this
property, there is only one key, namely textheight. This can be used to specify
the height of the minipage used for the main text. This does not imply that users
are restricted to this length or that powerdot does automatic slide breaking. This
height is only used for vertical alignments of material, for instance by footnotes.
The preset value is \slideheight.

This will be inserted just before the text that is about to be typeset. This can
be used to declare deviations from the main text font and color. It can be a
font declaration, like \large\bfseries, but can also contain other things like
\color{red}or \raggedright.

This property is only available for the footers (1f, cf and rf) and can be used
to change the template of the footers. This means that you can, for instance,
add content to the footer, besides the content specified by the user. The default
declaration by powerdot is the following.
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option
-orient

\pd@tocslide
\pd@tocsection

\pd@tocdisplay
\pd@tochighlight

option
tocfrsep

option
tocsecsep

rftemp=\pd@Orf\ifx\pd@@rf\Q@empty
\else\ifx\theslide\Q@empty\else\ -- \fi\filtheslide

Here \pd@@rf will contain the content of the right footer defined by the user
via the \pdsetup command. Similarly, \pd@@1f contains the content of the left
footer. The above declaration checks whether the footer and \theslide are both
non-empty and if so, it inserts -- to separate both.

-orient

This property is only available for the toc, stoc and ntoc components. This
property can be h or v and determines the orientation of the table of contents.
The preset is v. See also section 9.6 for more information about the construction
of the table of contents.

9.6 Slide toc

The small table of contents that is placed on slides can be controlled by four macros
and several options.

These macros take one argument. When building the table of contents, powerdot
first passes the content through \pd@tocslide or \pd@tocsection, depending on
the type of entry that it is building at that moment. You could, for instance, do

\def\pd@tocslide#1{$\bullet$\ #11}
\def\pd@tocsection#i{#1}

which will prefix all normal entries (not the sections) with a bullet. By default, these
two macros are defined to just pass on their argument.

These two macros also take one argument. After processing an entry with the com-
mand \pd@tocslide or \pd@tocsection, powerdot continues building the entry by
passing it through \pd@tocdisplay, when the entry needs to be displayed only, or
\pd@tochighlight, when the entry needs to be highlighted. These macros are a little
more involved and take care of putting the content in the proper font and color in a
minipage. Further, \pd@tochighlight also puts a box around the item.

Notice, that by default, both the separate table of contents entries as well as the
table of contents as a whole are typeset inminipage environments by these macros, in
case the table of contents is vertical. The -width properties then determines the width
of the table of contents and, together with tocsecindent and tocslideindent (see
below) the width of the individual entries. If it is horizontal, only the separate entries
will be in minipages and the table of contents itself not and the -width properties
determine only the width of the individual entries (together with tocsecindent and
tocslideindent).

Several aspects of the process of generating the table of contents can be controlled
via the keys that are available in the \pddefinetemplate command that will be de-
scribed below. If these keys do not provide enough handles to do what you want, you
might need to have a look at the two macros in the source and decide to rewrite them
in your style as to fit your needs. An example can be found in the fyma style.

This length is the distance between the box around the content created by the
minipage and the highlight frame box created by \pd@tochighlight. Preset:
0. 5mm.

tocsecsep

The distance inserted before a section (unless it is the first element in the table
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tocslidesep

option
tocsecindent

option
tocslideindent

option
tocsecm

option
toctcolor

option
tochltcolor

option
tochlcolor

option
iacolor

options
clockhook
clockpos

of contents). Preset: 2ex. Notice that if the orientation of the table of contents is
set to vertical, this length creates a vertical skip, otherwise, it creates a horizontal
skip.

tocslidesep

The distance inserted before other entries (unless it is the first element in the
table of contents). Preset: Oex. Like tocsecsep, the effect of this length depends
on the orientation of the table of contents.

tocsecindent

The horizontal space left to a section entry. Preset: Opt.

|tocslideindent|

The horizontal space left to a slide entry. The horizontal skip will not be inserted
left to slide entries that appear before the first section. Preset: Opt.

tocsecm

This is inserted just before typesetting a section. This can be used to mark a
section, for instance with a line as in the default style. Preset: empty.

toctcolor

This is the text color used for non-highlighted elements in the table of contents.
Preset: black.

tochltcolor

This is the text color used for highlighted elements in the table of contents. Pre-
set: white.

tochlcolor

This is the color used for the frame behind highlighted elements. Preset: black.

9.7 Miscellaneous options

There are some options that fall outside of the scope of the previous sections. These
will be discussed here.

iacolor

The iacolor option can be used to specify the color that is used for inac-
tive things, produced for instance by \onslide, \pause (see section 4) and
\tableofcontents (see section 5.2). As xcolor is used by powerdot, one can
use special notation here, like

iacolor=black!20

The preset value for this key is 1ightgray.

The following options control the digital clock (see section 2.1). The clock is a form
text field with dynamic content, driven by a javascript via hyperref text fields. Some
options for the clock work similarly as for, for instance, the title component, but there
are also special options.

clockhook| |clockpos

These work in the same way as the -hook and -pos properties discussed in sec-
tion 9.5. The preset value of clockhookis tr.
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options
clockwidth
clockheight

option
clockcharsize

option

clockalign

option
clockcolor

clockwidth| |clockheight

These control the width and height of the text field containing the clock. Preset
values come from hyperref and are 3cm and \baselineskip, respectively.

|clockcharsize|

The size of characters of the clock. Preset: 14pt.

clockalign

The alignment of the clock in the text field. 0 is left-aligned, 1 is centered and 2
isright aligned. Preset is 2.

This determines the text color of the clock. The value should be a named color.
The preset value is black.

9.8 Template presets

Below, we have copied the preset setting for the keys described above. These will be
used if you didn't supply other input for these keys in a particular template. If the
preset value meets your needs, you don't have to specify it again in your style.

titlehook=Bl,titlepos=,titlewidth=\slidewidth,
titlefont=\raggedright,texthook=tl,textpos=,
textwidth=\slidewidth,textfont=\raggedright,
textheight=\slideheight,
tochook=tl,tocpos=,tocwidth=.2\slidewidth,
tocfont=\tiny\raggedright,
stochook=tl,stocpos=,stocwidth=.2\slidewidth,
stocfont=\tiny\raggedright,
ntochook=tl,ntocpos=,ntocwidth=.2\slidewidth,
ntocfont=\tiny\raggedright,
tocorient=v,stocorient=v,ntocorient=v,
tocfrsep=.5mm, tocsecsep=2ex,tocslidesep=0ex,
tocsecm=,toctcolor=black,tochlcolor=black,tochltcolor=white,
tocsecindent=0pt,tocslideindent=0pt,
1fhook=Bl,1fpos=,1ffont=\scriptsize,lftemp=\pdQOlf,
cfhook=B, cfpos=,cffont=\scriptsize,cftemp=\pd0@Qcft,
rfhook=Br,rfpos=,rffont=\scriptsize,rftemp=\pd@@rf\ifx\pd@@rf
\@empty\else\ifx\theslide\Qempty\else\ -- \fi\filtheslide,
iacolor=lightgray,
clockhook=tr,clockpos=,clockwidth=3cm,clockheight=\baselineskip,
clockcharsize=14pt,clockalign=2,clockcolor=black

9.9 Thebackground

This leaves only one argument of the \pddefinetemplate macro undiscussed. This
is the (commands) argument. This argument can contain any code that you want to
execute after setting the options and before building the slide components like the slide
title, main text, and footers. This argument is designed to contain declarations that will
build the background of a template using, for instance, pstricks, but it can also hold
other commands you might need for building your template.

Important to notice is that these commands may not create TgX material as that
might destroy the construction of the slide. So, if you want to place the word ‘Hello’
in the bottom left corner of the slide, don’t type ‘Hello’, but make its width, height and
depth equal to zero, for instance by using pstricks’ \rput.

\rput [b1] (0,0){Hello}
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options
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9.10 Title slide, titles and sections

As mentioned before, the style that you write needs to define at least the templates
slide and titleslide. The latter treats some of the keys in a special way. Besides, a
section slide is also done in a special way.

The title slide (made with \maketitle) puts the title with author(s) and date in
the main text box. This means that you have to supply a position for the main text
box (textpos). It will use the main text font for the text (together with declarations
in the textfont key) for the author(s) and the date. But it will use the declarations
in titlefont for the title of the presentation. This is done so that title and author(s)
form a coherent block and to make sure that long titles can push down the author(s)
instead of overwriting it.

The \pd@slidetitle macro is used to typeset the slide title on slides. This macro
is comparable to for instance \pd@tocslide. The macro takes one argument which
is the slide title in the right font and formatting. By default, this macro just passes on
the content for typesetting, but you could redefine this macro so do something with its
input prior to typesetting it. An example is in the fyma style which underlines the title
after putting it in aminipage to support multi line titles.

These macros are similar to \pd@slidetitleand typeset the title on the title slide
and the title on section slides respectively. By default, these also pass there argument
(which is the presentation title or section title), but these can be redefined to do some-
thing with the input prior to typesetting it, just as \pd@slidetitle.

The \section command uses (by default) the slide environment and puts the
section title in the title box with font titlefont. If you want to change the default use
of the slide environment for sections to, for instance, the sectionslide environ-
ment or any other especially designed section template, change the section template
preset in your style, using

\setkeys [pd]{section}{sectemp=sectionslide}

This means that if the user asks for template=slidein the \section command, the
sectionslide environment will be used silently. To avoid surprises, sectionslide
should preferably be based on the s1ide environment.

A similar option is available in case the user asks for template=wideslide. One
could for instance do the following.

\setkeys [pd]{section}{widesectemp=sectionwideslide}

Whenever the user requests a wideslide to be used for a \section, instead, the
sectionwideslide environment will be used. Other input to the template key by
the user does not get a special treatment.

Notice that these keys are available in the section family of keys and that you
cannot use them in the \pddefinetemplate command.

9.11 Testing the style

powerdot has a test file that should test most of the style. This test file can be produced
by running BIEX over powerdot.dtx. This generates powerdot-styletest.tex
which will help you with the testing job. Feel free to contact us when you would like to
contribute your style to powerdot. See also section 11.

10 Using IyX for presentations
IyX [6] is a WYSIWYM (What You See Is What You Mean) document processor based

on BIEX. It supports standard BIEX classes but needs special files, called layout files, in
order to support non-standard classes such as powerdot.
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To start using IyX for powerdot presentations, copy the layout file powerdot . layout
to the IyX layout directory. You can find this file in the doc tree of your BIEX installa-
tion: texmf/doc/latex/powerdot. If you can't find it there, download it from CTAN:
/macros/latex/contrib/powerdot. Once that is done, reconfigure IyX (Edit>
Reconfigure and restart [yX afterwards). Now you can use the powerdot document
class as any other supported class. Go to Layout > Document and select powerdot
presentation as document class. For more information, see the IyX documentation,
which is accessible from the Help menu.

10.1 How to use the layout

The powerdot IyX layout provides some environments'? which can be used in IyX.
Some of these environments (for instance Title or Itemize) are natural to use since
they exist also in the standard document classes such as article. For more information
on these standard environments, see the [yX documentation.

This section will explain how to use the powerdot specific environments S1ide,
WideSlide, EmptySlide and Note. These environments correspond to the powerdot
environments slide, emptyslide,wideslide and note.

We start with a simple example. The following IIjX code

\begin{slide}{Slide titlel}
Slide content.
\end{slide}

can be obtained using the following IyX environments. The right column represents
the text typed into the IyX window and the left column represents the environment
applied to this text).

Slide Slide title
Standard Slide content.
EndSlide

Some remarks concerning this example.

* You can use the environment menu (under the menu bar, top-left corner) to change
the environment applied to text.

» The slide title should be typed on the line of the S1ide environment.

¢ EndSlide finishes the slide and its line is left blank.

In the IyX window, the Slide environment (that is, the slide title) is displayed in
magenta, the WideSlide style in green, the EmptyS1lide style in cyan and the Note
style in red and hence these are easily identifiable.

Here is another example.

\begin{slide}{First slide title}
The first slide.
\end{slide}
\begin{note}{First note title}
The first note, concerning slide 1.
\end{note}
\begin{slide}{Second slide title}
The second slide.
\end{slide}

This can be done in I¥X in the following way.

Slide First slide title

Standard The first slide.

Note First note title

Standard The first note, concerning slide 1.

12Don't confuse these with ISIEX environments.
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Slide Second slide title
Standard The second slide.
EndSlide

This example demonstrates that it is often sufficient to insert the EndS1ide style after
the last slide or note only. Only when you want certain material not to be part of a slide,
you need to finish the preceding slide manually using the EndS1ide style. Example:

Slide First slide title
Standard The first slide.
EndSlide

[ERT box with some materiall]
Slide Second slide title

Options can be passed to slide environments by using Insert> Short title in
front of the slide title. The following example uses the direct method (see section 6.4)
in the short title argument (delimited by square brackets) to allow for a 1stlisting
environment (defined by the listings package) within the slide content.

Slide [method=direct]Example of LaTeX source code
Standard Here’s the \HelloWorld command:
[ERT box:
\1stset{language=[LaTeX]TeX}
\begin{lstlisting}
\newcommand{\HelloWorld}{Hello World!}
\end{1lstlisting}
]
EndSlide

Note that you are not obliged to use a verbatimenvironment to type the \HelloWord
text into the IyX window because IyX directly supports standard verbatim.!*> Conse-
quently, the use of the slide processing methods direct and file is not necessary
when you need standard verbatim, but it is necessary when doing more advanced
things, like in the example above.

10.2 Support of syntax

This section lists options, commands and environments that are supported through
the IyX interface directly, without using an ERT box (TgX-mode).

All class options (see section 2.1) are supported via the Layout > Document dialog
(Layout pane). Options for the \pdsetup command (see section 2) should be speci-
fied in the Preamble pane of the Layout > Document dialog.

Table 3 lists the powerdot commands that are supported in IyX. Table 4 lists the
powerdot environments that, besides the earlier discussed slide, wideslide, note
and emptyslide environments, are supported in IyX. Table 5 lists commands that
can only be done by using an ERT box (via Insert > TeX). Note that you may use the
clipboard in order to repeat often used commands like \pause. Finally, table 6 lists
additional commands and environments that are supported by the layout.

10.3 Compiling with IyX

First of all, make sure that you have also read section 8. Then, in order to get a proper
PostScript or PDF file, you have to set your IyX document properties depending on
which paper and orientation you want. When your IyX document is open, go to the
Layout > Document dialog. In the Layout pane, put the nopsheader, orient and
paper keys as class options (see section 2.1 for a description). Then, go to the Paper

13L>,{X translates special characters into their corresponding IKTgX command. For instance, the backslash
character is translated into \textbackslash. Resulting, the font is not the same as in true verbatim and
you might want to change that via the Layout > Character dialog.
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Command Method in IyX
\title Use Title environment.
\author Use Author environment.
\date Use Date environment.
\maketitle Managed directly by IyX.
\section Use the Section environment. Options to this com-
mand (see section 5.1) can be specified using Insert >
Short titlein front of the section title.
\tableofcontents | Use Insert>Lists & TOCr> Table of contents.
You will need an ERT box if you want to use the optional
argument, see below.
Table 3: Supported powerdot commands in IyX
Environment | Method in IyX
itemize Use Itemize and ItemizeTypel environments. The
latter will create a list with type=1 (see section 4.2).
enumerate Use Enumerate and EnumerateTypel environments.

thebibliography | Use Bibliography environment.

Table 4: Supported powerdot environments in IyX

pane and select corresponding paper size and orientation (you may choose letter
paper in the case you set paper=screen in the class options). Finally, go to the View
(or File> Export) menu and select your output (PostScript or PDF).

10.4 Extending the layout

If you have created a custom style (see section 9) which defines custom templates, you

may want to extend the layout file'# so that these templates are also supported in IyX.

The explanation below assumes that you have defined a template called sunnyslide.
To support this new template in IyX, you have to use the following command.

\pddefinelyxtemplate(cs){(template)}

This will define the control sequence (cs) such that it will create a slide with template
(template) (which has been defined using \pddefinetemplate. This new control se-
quence can be used in the layout file as follows.

# SunnySlide environment definition
Style SunnySlide
CopyStyle Slide
LatexName lyxend\lyxsunnyslide
Font
Color Yellow
EndFont
Preamble
\pddefinelyxtemplate\lyxsunnyslide{sunnyslide}
EndPreamble
End

Note that you must begin the LatexName field with 1yxend. The definition of the IyX
template has been inserted in between Preamble and EndPreamble which assures
that the new IyX environment will work in every presentation. After modifying the
layout file, don't forget to restart IyX. See for more information about creating IyX en-
vironments, the documentation of [yX in the Help menu.

14The LPPL dictates to rename a file if you modify it as to avoid confusion.

38



Q1
Al

Q2

Q3
A3

Q4
A4

Q5

A5

Command Method in IyX

\and Within Author environment.

\pause

\item An ERT box is only required for the optional argument,
not mandatory for overlays specifications.

\onslide And the versions \onslide+and \onslidex.

\twocolumn

\tableofcontents | Only when using the optional argument.

Table 5: powerdot commands needing an ERT box in IyX

Env./Command | Method in IyX

quote Use Quote environment.

quotation Use Quotation environment.

verse Use Verse environment.

\caption Use Caption environment within standard float envi-
ronments.

Table 6: Additional environments for IyX

11 Questions

11.1 Frequently Asked Questions

This section is devoted to Frequently Asked Questions. Please read it carefully; your
problem might be solved by this section.

Does powerdot have example files? Where can I find them?

powerdot comes with several examples that should be in the doc tree of your BIEX in-
stallation. More precisely: texmf/doc/latex/powerdot. If you can't find them there,
download them from CTAN: /macros/latex/contrib/powerdot [7].

I'm getting errors or unexpected output when compiling the simplest example!
Did you read section 8?

I made a typo in the slide code, ran the file, got an error, corrected the typo and reran,
but now get an error that doesn’t go away.
Remove the .bmand . toc files and try again.

\pause does not work in the align'® environment.
align does several tricky things, which make it impossible to use \pause. Use
\onslide instead. See section 4.4.

My pstricks nodes appear on all overlays. Also: color doesn't seem to work with
\onslide.

Some PostScript tricks like nodes and color do not work with \ons1lide. Use \onslide*
instead. See an example below.

\documentclass{powerdot}
\usepackage{pst-node}

\begin{document}

\begin{slide}{Color}
\onslide*{2}{\cnode (0, -5pt){2pt}{A}}

This is {\onslidex*{2-}{\color{red}} red} text.
\onslide*{2}{\cnode (0, -5pt){2pt}{B}}
\onslide{2}{\ncline{A}{B}}

I5There are several environments doing similar things as align. Another example is the split environ-
ment, but more (often from the amsmath package) can cause similar trouble for \pause.
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\end{slide}
\end{document}

Do I need to edit style files to change a style a bit?

No, you do not need to edit any style file. You can change any part of a certain style
using the \pddefinetemplate and \pddefinepalettes commands. Here is an ex-
ample that removes the left and right footers from the default style, places the slide
number in the center footer and adds another palette.

\documentclass{powerdot}

\pddefinetemplate [slide]{slide}{
1fpos=,rfpos=,cftemp=\theslide

H}

\pddefinepalettes{mypalettel}{
\definecolor{pdcolori}{rgb}{.27, .31, .44}
\definecolor{pdcolor2}{rgb}{.85,.85,.92}
\definecolor{pdcolor3}{rgb}{.8, .75, .98}

¥

\pdsetup{palette=mypalette}

\begin{document}

\begin{slide}{Title}

\end{slide}

\end{document}

See section 9 for more information about these two commands.

Can I contribute to this project?

Certainly. If you find bugs!® or typos, please send a message to the mailinglist (see
section 11.2). If you have developed your own style that is distinct from existing styles
and would like to see it included in powerdot, please inform us by private e-mail and
we will consider your contribution. Notice that included contributions will fall under
the overall powerdot license and copyright notice, but that your name will be included
in the documentation when you make a contribution. This is done to guarantee that
we can adapt files if maintenance is needed.

Hyperlinks in the presentation seem off by 1 page.
This might happen in particular PDF viewers when using paper=smartboardin com-
bination with continuous view. Use page by page view instead.

If your question has not been answered at this point, advance to the next section
to read where to find more answers.

11.2 Mailinglist
powerdot has a mailinglist from freelists.organd has its website here:
http://wuw.freelists.org/list/powerdot

There is a link to ‘List Archive’. Please search this archive before posting a question.
Your problem might already have been solved in the past.

If that is not the case, use the box on the page to type your e-mail address, choose
the action ‘Subscribe’ and click ‘Go!. Then follow the instructions that arrive to you
by e-mail. At a certain moment, you can login for the first time using an authoriza-
tion code sent to you by e-mail. After logging in, you can create a password for future
sessions using the ‘Main Menu’ button. The other buttons provide you some info and
options for your account.

When you are all set, you can write to the list by sending an e-mail to

16Make sure that you confirm that the bug is really caused by powerdot and not by another package that
you use.
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powerdot [at] freelists[dot]org

When writing to the list, please keep in mind the following very important issues.

. We are volunteers!

. Keep your questions related to powerdot.

. Always supply a minimal example demonstrating your problem.
. Don't send big files over the list.

We hope you will enjoy this service.

12 Source code documentation

In case you want regenerate the package files from the source or want to have a
look at the source code description, locate powerdot.dtx, search in the file for
\OnlyDescriptionand remove that and do

latex powerdot.dtx

latex powerdot.dtx

bibtex powerdot

makeindex -s gglo.ist -o powerdot.gls powerdot.glo
makeindex -s gind.ist -o powerdot.ind powerdot.idx
latex powerdot.dtx

latex powerdot.dtx
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